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INFORMATION TECHNOLOGY- CLASS X 

CHAPTER – WORD PROCESSING 

 

SESSION 1:- MODIFYING LAYOUT OF A PARAGRAPH 

Q1. What is a Paragraph ? 

 Ans Paragraphs can be used to break continuous text to one or more sentences. 

Q2. Write a short on Tabs. 

Ans Tabs are often the best way to control exactly where text is placed. By default, every time 

        you press the Tab key, the insertion point will move ½ inch to the right. 

        By adding Tab Stops to the ruler, you can change the size of the tabs, and you can even 

        have more than one type of alignment in a single line. 
 
Q3. Write the steps to create the tab position at “5”.   

Ans :  1. Click Page Layout tab on the Ribbon. 

 2. Click Launcher Arrow under Paragraph group. 

 3. The Paragraph dialog box appears.  

 4. Click on Tabs button, Tabs dialog box appears. 

 5. You can specify the tab position i.e. 5 by mentioning the stopping position in the Tab 

  Stop position box. 

 6. After specifying the tab stop position click on Set button. 

 

Fill ups ( Do it yourself from your IT book ) 

 

1. Paragraph group is available under __________tab . 

2. Default tab position is  _________ 

3. Tabs option is present on _________ tab. 

 

SESSION 2:- MANAGING HEADERS 
 

Q1. What is Header ? 

Ans   A  Header is an area that appears at the top of every page. 

         It includes text or graphics 

         We can also apply formatting on the text in a header. 
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Q2. What are the steps to insert header ? 

Ans     1. Click on the Insert tab on the Ribbon. 

 2. Click on the option Header in the Header & Footer group. 

 3. A drop down menu will appear showing various built in header options. Select any option. 

4. The Design tab will appear on the Ribbon & the header area will appear in the document 

 5. Type the desired information in the header. 

 6. When you are finished , click the Close Header & Footer in the Design tab or press 

   Esc key. 

Q3. Write the steps to add page number in header. 

Ans  1. Click the Insert tab in the Header & Footer group. 

 2. Click the Page Number command button. 

 3. A drop down menu appears showing page number style. 

 4. Select a page numbering style. The page number will be inserted in the document. 

Q4. How we can format page number ? 

Ans  1. Click Insert tab in the Header & Footer group. 

 2. Click the Page Number command button. 

 3. A drop down menu appears , click Format Page Numbers. 

 4. The Page Number Format dialog box appears. 

 5. Select the page number format. 

Q5.  How we can add Date & Time , Picture and Clip Art options on header area ? 

Ans  These options are available under Insert group on Design tab. 

Q6. List any 5 items that can be added to the header area. 

Ans Picture , Page number , Date , Time and any Company’s logo. 

 

Fill ups ( Do it yourself from your IT book ) 

 

1.  ________ can be used for inserting information at the top of each page automatically. 

2. Header option is available under _______ group in _________ tab. 

3. Picture option is present on ________ tab. 

4. Date & Time option are available under __________ group. 
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SESSION 3:- MANAGING FOOTERS 
 

Q1. What is Footer ? 

Ans   A  Footer is an area that appears at the bottom of every page. 

         It includes text or graphics 

         We can also do editing  on the text in a header. 

 

Q2. What are the steps to insert Footer ? 

Ans     1. Click on the Insert tab on the Ribbon. 

 2. Click on the option Footer in the Header & Footer group. 

 3. A drop down menu will appear showing various built in footer options. Select any option. 

4. The Design tab will appear on the Ribbon & the footer area will appear in the document 

 5. Type the desired information in the footer. 

 6. When you are finished , click the Close Header & Footer in the Design tab or press 

   Esc key. 

 

Fill ups ( Do it yourself from your IT book ) 
 
1. ________can be used for inserting information at the bottom of each page automatically. 

2. The Footer option is available under Header & Footer group in ____________Tab 

 

SESSION 4:- MANAGING FOOTERS 
 
Q1. What is Styles ? 

Ans A Styles is a predefined combination of font style, color and size of text that can be applied 

        to selected text.  

Q2. How do you select a style ? 

Ans  1. Select the text you want to format. 

        2. Click the Home tab , under the Styles group. 

 3. Select the style you want to apply. 

 4. The selected style will be applied on the text. 

 

Q3. What is Style set ? 

Ans Style set include a combination of title, heading and paragraph styles. 
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Q4. Write the steps to apply a style set. 

Ans 1. Click the Change Styles command in the Styles group of the Home tab. 

 2. A drop down menu will appear. 

 3. From the drop down menu , select the Style Set. 

 4. A drop down list of styles appears. 

 5. Select the Style Set you want to apply on the document. 

  

 

Fill ups ( Do it yourself from your IT book ) 
 

1. ____________ are customized or pre-defined options for creating professional looking   

    documents with the minimum efforts. 

2. You can change styles by using the _________ group under the Home tab. 

3. Change Styles option is available in __________ tab. 

4. Under _________tab , Style set option is present. 

 

SESSION 5:- DOCUMENT TEMPLATE 
 

Q1. What are Document Template ? 

Ans 1. Templates or document templates refer to a sample fill-in-the-blank document that can  

      help in saving time. 

 2. Usually templates are customized documents that may have sample content, themes etc. 

 3 For e.g. if you want to create a resume you can use a resume template & modify only 

   sections  that require changes. 

Q2. What are the steps to insert templates ? 

Ans 1. Click the File tab.  

2. Select New. The New Document pane appears. 

3. Click the Sample Templates or Installed Templates to choose a built-in template. 

4. Select any one of the template. 

Q3. Mention some websites that offer free templates ? 

Ans  1. Office.microsoft.com/templates 

 2. www.thepapermillstore.com 

 3. openoffice.blogs.com/openoffice/templates 

4. www.docstoc.com 

http://www.thepapermillstore.com/
http://www.docstoc.com/
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Q4. Write advantages of using Document Templates ? 

Ans  1. It contains predefined formatting  styles, graphics ,tables , objects  & other information. 

 2. Save your time & effort because all the work it takes to design the document has already 

     has been done. 

 

Fill ups ( Do it yourself from your IT book ) 
 

1. Templates or document templates refer to a _______________ document. 

2. Document templates is present on ___________ tab. 

 

SESSION 6:- WORKING WITH PAGE & SECTION BREAKS 
 
Q1. What is Page break ? What are the different types of Page Break ? 

Ans Page Break move the text to a new page before reaching the end of page. 

 Page Break includes the following 3 types of breaks :- 

1. Page – This option is used when you want to start typing a text on a new page with the same 

       formatting. 

2. Column – This option is used to create a multi-columned document. By using column break, 

  you can move to the next column, leaving your previous text in the first column. 

  This option is used in newspaper writing , magazines etc. 

3. Text Wrapping – It will separate the text you use to type in a caption for a picture, or other 

  object, from the body of the text. Also, this option keeps the text around the objects 

  together with consistent formatting. 

 

Q2. Write the steps to insert Page break ? 

Ans 1. Place the insertion point where you want the break to appear. 

 2. Select the Page Layout tab. 

 3. Click the Breaks command in the Page Setup group. 

 4. A dropdown list with options for different types of breaks appears. 

 5. Select any type of Page break. 

 

Q3. What are Section breaks ? What are the different types of Section Break ? 

Ans Section breaks can be used to separate a document into sections. To separate a section in a 

 document, you can use the section break. 

1. Next Page – It inserts a section break and starts the new section on the next page. It is 

      especially useful for starting new chapters in a document. 
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2. Continuous – It inserts a section break and starts the new section on the same page.  

 

3. Even Page – It inserts a section break and  starts the new section on next even-numbered page. 

 

4. Odd Page - It inserts a section break and  starts the new section on next odd-numbered page 

 

Q4. Explain how a section break helps in formatting a document. 

  Add flexibility to formatting a document. 

 We can separate the chapters as separate sections in our document 

 We can create different headers & footers, different footnote numbering, change the layout of 

columns ,change page borders for different pages, and even change page layouts in the 

same document. 

 

Q5. Write the steps to insert Section break ? 

Ans 1. Place the insertion point where you want the break to appear. 

 2. Select the Page Layout tab. 

 3. Click the Breaks command in the Page Setup group. 

 4. A dropdown list with options for different types of Section breaks appears. 

 5. Under Section Breaks select the required section break. 

 

Q6. What are the steps to delete a section break ? 

Ans  1. Click Show/Hide button on the Home tab in the Paragraph group. 

 2. Section/page breaks are displayed in your document. 

 3. Click on the Section/page break. 

 4. Press Delete on your keyboard & the section/page break is removed. 

                                                          OR 

 1. Click Draft view so that you can see the double dotted line section break. 

 2. A dotted line will appear showing section break. 

 3. Select the section break that you want to delete. 

 4. Press Delete key. 

 

Fill ups ( Do it yourself from your IT book ) 
 

1. _______ & _________ breaks can be used to separate a document into sections. 

2. Using page breaks , you can create different _____________ 
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3. A section break controls the__________ of the document content that precedes it, until it  

        reaches another section break. 

4. To see a section/page break ,click the _______ button on the Home tab in Paragraph section. 

5. Page break command is available in ______________ tab. 

6. Section break option is present on _____________ group. 

 

SESSION 7:- APPLYING CHARACTER FORMATS 
 

 Font Face: After selecting the text you need to click Font Name in the Font group to select 

the particular font style from the fonts listed. 

 

 Font Size: After selecting the text you need to click Font Size in the Font group to select the 

particular font size from the values given. 

 

 Grow Font: After selecting the text you need to click the  icon in the Font group to make 

the font size larger than the current font size by the specified point. 

 

 Shrink Font: After selecting the text you need to click the  icon in the Font group to make 

the font size smaller than the current font size by the specified point. 

 

 Strikethrough: After selecting the text you need to click the  icon in the Font group to 

make a strike through the middle of the selected text. 

 

 Subscript: After selecting the text you need to click the  icon in the Font group to make 

the selected text lower than the normal text position. 

 

 Superscript: After selecting the text you need to click the  icon in the Font group to 

make the selected text higher than the normal text position. 

 
 Clear Formatting: Clear Formatting is used to clear the character formatting (such as Bold, 

           Italics ,Underline, font face & size, superscript & subscript etc.) of the selected text. To 

          remove the character formatting, select the text and click on   icon in the Font group. 

 

 Text Highlight Colour: Use this option to change the background colour. To do so, select 

the text and click on  icon in the Font group. You can choose the background colour by 

clicking on the down arrow on the icon. 
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 Font Colour: Use this option to change the colour of the text. To do so, select the text and 

click on  icon in the Font group. You can choose the text colour by clicking on the down 

arrow on the icon. 

 
 Change Case: Word processor helps us to change the text case to capital letters or small 

letters. You can also capitalize each word in the sentence and capitalize the starting word of 

the sentence using Change Case under Font Group. To do so, after selecting the text you 

need to click the   icon in the Font group. 

 
 Sentence Case: On selecting this option from the dropdown list, the first character in the first 

           word of the selected sentence will be converted to Capital Letter (Uppercase). 

 

 Lowercase: On selecting this option from the dropdown list, the selected text will be 

converted to Small Letters (lowercase). 

 

 UPPERCASE: On selecting this option from the dropdown list, the selected text will be 

converted to Capital Letters (UPPERCASE). 

 
 Capitalize Each Word: On selecting this option from the dropdown list, the first character in 

all the words of the selected sentence will be converted to Capital Letter (Uppercase). 

 
 tOGGLE cASE: On selecting this option from the dropdown list, the small letters in the 

selected text will be converted into capital letters and capital letters will be converted into 

small letters. 

       

Fill ups ( Do it yourself from your IT book ) 
 

1. After selecting the text you need to click the _________ in the Font group to make the font size 

    larger than the current font size. 

2. To remove the character formatting, select the text and click on ___________ in Font group 

3. On selecting _________ , the first character in the first word of the selected sentence will 

    be converted to Capital Letter. 

4. On selecting ______________ , the first character in all the words of the selected sentence 

    will be converted to Capital Letter. 

5. Grow font is available in _________ group & __________ tab. 
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SESSION 8:- INSERT GRAPHICAL OBJECTS AND ILLUSTRATIONS 
 

Q1. What are Objects in a Word processing software ? 

Ans Sounds, music, drawings, documents spreadsheets etc. are all examples of possible objects 

        that you can include in a document, or link to a document. 

 

Q2. What is Clip Art ? 

Ans Clip Art can help in making a document look colourful and presentable. Clip arts are  

         pre-defined images available for use in documents. 

 For e.g. – if you would like to create a greeting card for your friend, you can use clip arts 

          Such as ballon, flowers, etc. along with text message. 

 

Q3. How do you insert images using Clip Art ? 

Ans  1. Select the Insert tab on the Ribbon. 

 2. Click the Clip Art command in the Illustrations group. 

 3. The Clip art task pane appears to the right of the document. 

 4. Enter a keyword in the Search for: field which is related to the image you wish to insert. 

 5. Click Go , once you click Go , a window appears along with list of clip arts matching  

               the search keyword. 

 6. Select the clipart that you want to use, double-click on it and it will be inserted into your 

     document. 

 

Q4. List any 5 websites that offers free clip arts. 

Ans : 1. www.openclipart.org 

 2. www.pdclipart.org 

 3. www.clker.com 

 4. www.freeclipartnow.com 

 5. www.wpclipart.com 

 

Fill ups ( Do it yourself from your IT book ) 
 

1. Clip Art can help in making a document look __________ and _________ 

2. Clip Art is available under_____________ group in__________ tab    

 

 

http://www.openclipart.org/
http://www.pdclipart.org/
http://www.clker.com/
http://www.freeclipartnow.com/
http://www.wpclipart.com/
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SESSION 9:- TEXT WRAPPING 
 
Q1. What is Text Wrapping ? 

Ans The term Text wrapping refers to a text formatting option which allows you to place an image 

        in the midst of a block of text. 

 

Q2. What are the steps to wrap the text ? 

Ans  1. Select the image. The Format tab will appear. 

 2. In the Format ribbon Click the Wrap Text command in the Arrange group . 

 3. The drop-menu menu will appear. 

 4. Select the desired menu option.  

5. The text will adjust based on the option you have selected 

 

Q3. List any 5 word wrapping options available in a word processing software. 

Ans Square, Tight, Through,  Top and Bottom,  Behind Text 

 
Fill ups ( Do it yourself from your IT book ) 

 
1. To search for a picture, place the cursor before the text , click ______tab and click _________  

        under ________ group. 

2. After you have inserted the picture, you can wrap the text by using the _________ option. 

3. The Wrap text option is available in _________ tab. 

4. Under Format tab, Wrap text command is present in _________ group. 

 
 

SESSION 10:- INSERTING OBJECTS 

 
Q1. What is OLE ? 

Ans OLE ( Obejct Linking and Embedding) is used to make the content that is created in one 

         program available in another program. 

 For e.g. you can insert an Office Excel workbook in an Office Word document. 
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Q2. Differentiate between Linking and Embedding a document. 

Ans  

 

 

 

 

 

 

 

Q3. Write the steps to link an object. 

Ans  1. Select the Insert tab  and click Object option in the Text group. 

 2. Click on drop down arrow and select Object option. 

 3. The Object dialog box appears. Click the Create from File tab. 

 4. Click on Browse button and browse dialog box appears. 

 5. Select the file you want to link and click the Insert. 

NOTE :- If you want to display the content of the linked file in a document then select the  

     Link to file check box. Otherwise, select Display as icon check box to display the icon 

     of the selected linked file in the document. 

 

Q4. What are the steps to embed an object ? 

Ans  1. Select the Insert tab  and click Object option in the Text group. 

 2. Click on drop down arrow and select Object option. 

 3. The Object dialog box appears. Click the Create New tab.  

 4. In the Object type box, Click the type of object that you want to create. 

 5. Click OK. 

 
Fill ups ( Do it yourself from your IT book ) 

 
1. Embedded objects __________ be printed. 

2. When you embed objects in a document, you may have trouble emailing it because __________ 

     

 

 
 

 

                       Linking              Embedding 

1. Linked objects remain as separate files, 

and they can be updated. 

1. Embedded objects are stored in the file 

that they are inserted in and they are not 

updated. 

2. Change in source file reflected in the 

target file. 

2. Change in source file does not reflect in 

the target file. 
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SESSION 11:- INSERT SHAPES, SYMBOLS AND SPECIAL CHARACTERS 

Q1. What are the steps to insert a shape ? 

Ans  1. Click on the Insert tab on the ribbon. 

 2. Click the Shapes command in the Illustrations group 

3. A drop down menu appears. Select a shape as per your requirement. 

 

Q2. How do you insert special characters and symbols in a document ? 

Ans  1. Click on the Insert tab on the ribbon. 

 2. Click on Symbol in Symbols group. 

 3. Click on Symbol option and for more symbols click More Symbols 

 4. Symbol dialog box appears. 

 5. Under Symbols tab select any symbol and click Insert. 

 6.  Under Special Characters tab select any character and click Insert. 

  

Fill ups ( Do it yourself from your IT book ) 
 
1. You can insert lines, basic geometric shapes, arrows ,equation shapes , flowchart shapes, stars, 

       banners and callouts using the __________ option. 

2. Symbol option is available under ____________ group in the Insert tab 

3. Shape command is available in _________ tab. 

4. ___________ group Shape option is present. 

5. Special characters option is available under Symbols group in the __________ tab. 

 
 


